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I. Concepts: FVS Reporting of Vegetative Structural Stage 

 

There are two Forest Vegetation Simulator (FVS) post processing programs available to report Vegetative 

Structural Stage (VSS): RMVSS and FVSStand.  This paper will describe how to use each of these programs to 

output VSS values.  Consideration for Northern Goshawk habitat requires analysis at three levels: Within a 

forest stand; At the forest stand; and, Amongst many forest stands.  Methods to address these various scales will 

also be presented in this paper.  The Cedro project area on the Cibola National Forest will be used as an 

example. 

 

II. FVS/VSS Analysis: Within a Forest Stand 

 

Follow these steps to process inventory point data: 

 

Execute the Suppose interface by clicking the Suppose icon. 

 

Plot Selection (a.k.a. Within Stand Level - inventory point, subplot) 

 

 

1. Select “Preferences” on the main menu bar in 

Suppose. 

2. Select “Suppose Preferences” menu option. 

  



 

 

3. The “Process plots as stands” Suppose 

preference should be set to “Yes”. 

4. Click the “Apply” button. 

5. Click the “Close” button to return to the main 

Suppose window. 

 

 

 

 

 

 

 

 

 

6. Select “File” on the main menu bar in Suppose 

7. Click “New” to clear previous simulation from 

memory. 

8. Select “File” on the main menu bar in Suppose. 

9. Click “Open Locations File”. 

10. Navigate to your project folder (i.e. 

C:\FVSData\Cibola\Cedro). 

11. Select the “Suppose.loc” file. 

12. Click the “Open” button. 

13. In the left window pane, under the “Pick 

Locations First” header, select “FSVEG”. 

14. In the middle window pane, under the “Pick 

Groups First header, select “All_Plots”. 

15. In the right window pane, click the “All Stands” 

button to select all inventory points. 

16. Click the “Add ### Stands” button. 

17. Click the “Close” button. 

 

 

Modify Time Scale (optional) 

 

18. Click the “Select Modifiers” button on the main 

Suppose window. 

19. In the left pane of the “Model Modifiers” 

window, choose the “Modify Time Scale” list 

option. 

20. In the right pane, choose the “Set inventory 

year” list option. 

21. In the “Set inventory year” window, enter “2013” 

(i.e. current year) as the “Starting date for the 

stand projection”. 

22. Click the “Okay” button. 

  



23. Next, in the right pane of the “Model Modifiers” 

window, choose the “Set the number of cycles” 

list option. 

24. To report existing conditions only, accept “1” as 

the “Number of cycles to be projected”. To 

project beyond existing conditions, enter an 

appropriate value equal to the total number of 

years divided by the projection cycle length (e.g. 

200 years/10 year cycle length = 20 cycles). 

25. Click the “Okay” button. 

26. In the right pane of the “Model Modifiers” 

window, choose the “Set time interval for a 

cycle” list option. 

27. For “FVS cycle number”, specify “0” to 

indicate for all projection cycles. 

28. Leave “Cycle length” set to default value. 

29. Click the “Okay” button. 

30. “Close” the “Model Modifiers” window. 

 

Delete Base Model Reports (optional) 

 

31. Click the “Select Outputs” button on the main 

Suppose window. 

32. In the left pane of the “Model Outputs” window, 

choose the “Base FVS Reports” list option. 

33. In the right pane, choose the “Delete Base 

Model Reports” list option. 

34. Select to check the “Delete the stand 

composition table”, “Delete the selected 

sample tree table”, and “Delete the activity 

schedule table”. This will eliminate the 

percentile tables and unnecessary activity 

schedule table from the FVS Main Output 

report. 

35. Click the “Okay” button. 

 

FVSStand Treelist (MANDATORY!!!) 
 

36. In the left pane of the “Model Outputs” window, 

choose the “Base FVS Treelists” list option. 

37. In the right pane, choose the “Build FVSStand 

Alone Treelist” list option. 

38. To report existing conditions only, click the 

“Inventory Year” radio button. To report 

projection years beyond existing conditions, 

click the “Inventory Year and All Cycles” 

radio button. 

39. Click the “Okay” button. 

40. “Close” the “Model Outputs” window. 

 

  



Select Post Processors (MANDATORY!!!) 
 

41. Click the “Select Post Processors” button on the 

main Suppose window. 

42. In the upper pane of the “Select Post Processors” 

window, choose the “View the Main Output file 

using system editor” list option. 

43. Click the “Include” button. 

44. In the upper pane of the “Select Post Processors” 

window, choose the “Rocky Mountain 

Vegetative Structural Stage” list option. 

45. Click the “Include” button. 

46. In the upper pane of the “Select Post Processors” 

window, choose the “FVSSTAND Alone: 

Generate Dynamic Yield Reports” list option. 

47. Click the “Include” button. 

48. “Close” the “Select Post Processors” window. 

 

 

Run Simulation 
 

49. Click the “Run Simulation” button on the main 

Suppose Window. 

50. Creatively name your simulation in the “Save As” 

window. Click “Save”. 

51. Click the “Run” button. 

 

 

 

 

 

 

 

 

 

 

View FVS Main Output Report 
 

52. Review the “Options Select by Input” table for 

error listings. Make corrections if needed. 

53. “Close” system editor. 

 

 

  



View RMVSS Post Processor Report 
 

54. Review the “Vegetative Structural 

Stage” table. Note the stand number and 

associated inventory point. 

 

 

Note: the RMVSS post processing program 

provides the most detail regarding the VSS 

computation. Subtotals by structural stage 

class for the number of trees, basal area, 

quadratic-mean-diameter, stand density index, 

and percent stand density index are displayed. 

The computed Structural Stage is presented. 

Successive stand/plots follow in the listing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

55. Compare values in the “Vegetative 

Structural Stage” table with the 

“Summary Statistics” table from the FVS 

Main Output Report. 

56. “Close” system editor. 

 

  



View FVSStand Post Processor Report 
 

57. Step 2 of the FVSStand_Wizard will appear on the 

screen. Default configurations should suffice. Click the 

“Next” button. 

 

Users can run FVSStand outside of the Suppose 

interface {i.e. Alone} in which case, Step 1 of the 

FVSStand_Wizard will prompt for the location of the 

FVSStand Treelist file. 

 

 

 

58. Step 3 of the FVSStand_Wizard will appear next on the 

screen. Select the appropriate “USFS Region” under the 

“Vegetation Classification” header. Default values 

should suffice. Click the “Finish” button. 

 

 

 

 

 

 

 

 

 

59. When prompted by the “Process Complete” message 

box that FVSStand is “Finished linking FVS Treelist 

Files”, click the “Ok” button to continue. 

 

 

 

 

 

 

 

 

60. The FVSStand “Activity Log” 

window will appear next on the 

screen. As directed, click the “X” 

in the upper right corner of the 

window to continue. 

 

61. The FVSStand “Print Preview” 

window will appear next on the 

screen. Click “Veg Attributes” 

tab on the upper left menu strip. 

62. The “RM_VSS” column is 

displayed toward the right of the 

print preview window. 



 

63. Click the “Finish” button.



Import FVSStand Veg_Class Report into a Spreadsheet 
 

64. Navigate to your working folder. Open the “{Keyword_Filename}_Veg_Class.txt” file (e.g. 

Cedro_Plo_Veg_Class.txt) in your favorite text editor. 

 

 

65. From the “File” menu, click the “Select All” option. 

 

 

 

 

  



66. From the “Edit” menu, click the “Copy” option. “Minimize” your text editor. 

 

 

67. Open “MS-Excel”. 

68. Format cells in “Column A” as “Text”. To do so, click the “A” above the left-most column to highlight the 

entire column. Right mouse click to display a quick-pick pop-up menu. Click “Format Cells…”. 

 

 

  



69. Right mouse click while in “Column A”. A quick-pick pop-up menu will appear. Gently slide your mouse 

down the option list passed the “Paste Options” to the “A” symbol and select this icon.  

 

70. Choose “OK” to the Microsoft Excel message regarding “Data on the Clipboard is not the same size and 

shape as the selected area. Do you want to paste the data anyway?” 

71. Click the “Data” menu. Choose the “Text to Columns” option. 

  



 

 

72. Step 1 of the “Convert Text to Column Wizard” will 

appear on the screen. Choose “Fixed width” to properly 

parse the text into spreadsheet columns. Click “Next”. 

 

 

 

 

 

 

 

 

 

 

73. Step 2 of the “Convert Text to Column Wizard” will 

appear on the screen. Verify that the various text fields are 

divided appropriately. You can adjust by using the mouse 

to move the lined-arrow. When satisfied all is correct, 

click “Next”. 

 

 

 

 

 

 

 

74. Step 3 of the “Convert Text to Column Wizard” will 

appear on the screen. You can review and set the format of 

each column by clicking the heading of the column and 

choosing the appreciate format option. When satisfied all 

is correct, click “Finish”. 

 

 

 

 

 

 

 

  



75. Now that your data is separated into columns, you can find “RM_VSS” in “Column P”. You can format 

Column P as “Text” and center the data if you wish. “Close” your text editor. 

 

 

 

Create Base.kcp Addfile (optional) 

 

76. Select the “Set inventory year” entry on the main 

Suppose window. 

77. Click the “Write” button toward the lower-middle 

portion of the Suppose window. 

78. The “Write to file” window appears. Provide a file 

name in the text box (i.e. Base). 

79. Click the “Save” button. 

 

 

 

 

 

 

80. Select the “Set the number of cycles” entry on the 

main Suppose window. 

81. Click the “Append” button toward the lower-

middle portion of the Suppose window. 

82. The “Append to file” window appears. Click the 

“Base.kcp” file. 

83. Click the “Open” button. 

84. Repeat Steps 80-83 for “Set time interval for a 

cycle”, “Delete Base Model Report”, and “Build 

FVSStand Alone Treelist” entries. 

 

  



III. FVS/VSS Analysis: At the Forest Stand 

 

Follow these steps to process individual stands: 

 

Stand Selection (a.k.a. Stand Level - polygon) 

 

1. Select “Preferences” on the main menu bar in 

Suppose. 

2. Select “Suppose Preferences” menu option. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. The “Process plots as stands” Suppose 

preference should be set to “No”. 

4. Click the “Apply” button. 

5. Click the “Close” button to return to the main 

Suppose window. 

 

 

 

 

 

 

6. Select “File” on the main menu bar in Suppose 

7. Click “New” to clear previous simulation from 

memory. 

8. Select “File” on the main menu bar in Suppose. 

9. Click “Open Locations File”. 

10. Navigate to your project folder (i.e. 

C:\FVSData\Cibola\Cedro). 

11. Select the “Suppose.loc” file. 

12. Click the “Open” button. 

13. In the left window pane, under the “Pick 

Locations First” header, select “FSVEG”. 

14. In the middle window pane, under the “Pick 

Groups First header, select “All_Stands”. 

15. In the right window pane, click the “All 

Stands” button to select all inventory points. 

16. Click the “Add ### Stands” button. 

17. Click the “Close” button.  



Insert Base.kcp Addfile (optional) 
 

18. Click the “Insert From File” button on the main 

Suppose window to include keyword entries 

created during the “Within Stand Level” run. 

19. The “Insert component from file” window will 

appear. Select “Base.kcp”. 

20. Click “Open”. 

 

 

 

 

 

 

 

 

 

 

21. The “Set inventory year”, “Set the number of 

cycles”, “Set time interval for a cycle”, “Delete Base 

Model Report”, and “Build FVSStand Alone 

Treelist” entries are inserted under the 

“Group:All” label. 

 

 

 

 

 

 

 

 

 

Note: The “Stand Level” processing is exactly the same as the “Within Stand Level” processing procedures. 

Pick up the individual steps beginning with Step 41 on Page 4 - Select Post Processors of this document. 

 

  



IV. FVS/VSS Analysis: Amongst Many Forest Stands 

 

Follow these steps to process many stands: 

 

Multiple Stand Selection (a.k.a. Project Level – component, watershed) 
 

1. Navigate to your working folder. 

2.  Open the spreadsheet containing the individual inventory point data (i.e. Cedro_plt.xlsx). 

3. Position mouse in Row 1 of “RM_VSS” column, highlight its title. 

4. Click “Data” menu, “Sort” icon. 

5. Click down arrow of “Sort by” text box and choose “RM_VSS”. 

 

 

6. Click the “OK” button of the “Sort” window. 

 

7. Click “Data” menu, “Subtotal” icon. 

8. Under “Add subtotal to” listing, click checkmark next to “PROJ_YEAR” to deselect. 

9. Scroll up to the “RM_VSS” item and select to check. 

10. Under “Use function” listing, use the down arrow in the text box to select the “Count” option. 

11. Under “At each change in” listing, use the down arrow in the text box to select the “RM_VSS” option. 

12. Click the “OK” button. 

 

  



 

13. Click the “2” button located on the left corner of the subtotal spreadsheet. 

 

 

  



14. Column “O” contains the number of inventory point by VSS class. 

15. To edit the subtotals, select associated columns and rows. Right mouse click to pop menu. Click “Copy”. 

16. In WordPad, “Edit” menu, “Paste Special”, “Unformatted Text”. 



17. There is a hard “Tab” character between the “Count” label and inventory plot count. 

18. Simply use the “Delete” key on your keyboard to remove. 

19. Replace with a “Space” key on your keyboard. 

20. Values can now be copy and paste into MS-Word or MS-Excel for further processing. 

 

 

 

Considerations: 

 

1. RM_VSS by Forest Type: 

 

 

 

2. FSVeg Forest Type = Society of American Foresters Classification. 

 

  



 

 

3. RM_VSS-Read Output 

 





Notes: 

 


